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1. Set Up GCP API Access

1.1. Overview

NetBrain IE system retrieves the data from Google Cloud Platform (GCP) via REST API as a Service Account or OAuth

Client. To enable NetBrain IE to retrieve the GCP data, you need to:
v" Enable GCP APIs
v' Set up Service Account (Recommended)

v' Set up OAuth 2.0 Client (Alternative)

1.2. Enable GCP APIs

NetBrain IE system requires access to the following GCP APIs:
= Compute Engine API
= Cloud Logging API
= Cloud Resource Manager API
*= Cloud DNS API
= Service Usage Viewer

= Stackdriver Monitoring API
Follow these steps to enable the required API libraries:

1. Inthe GCP Console, go to the API Library page.
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2. Search or browse the library to find the required APIs like Compute Engine API.

= Google Cloud Platform I Project Test v

€ APILibrary
| *

| Welcome to the API Library [ ]

The APILI lirks, and a smart
(] x
. [ ] -
-
|
S ——
| SO ———
Filter by Maps VIEW ALL (15)
| ! ke . 2 &
Maps SDIfor 05 [T—— Places 4P1 Roads AP1
| o P - oo

VW AL ()

tural Languzge AFI
e

3. Select Compute Engine API to open it. Click ENABLE.
e

Compute Engine API

Google Enterprise 4P|

LLLJ
Compute Engine API

Y ThiS AP

OVERVIEW DOCUMENTATION SUPPORT

Overview
Creates and runs virtual machines on Google Cloud Platform Additional details

Type: SaaS & APIs
Last updated:
Category: Compute, Networking, Google Enterprise APls

Service name: compute.googleapis.com

4. Repeat steps 2 and 3 to enable all other required APIs.
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1.3. Set Up Service Account

1.3.1. Create Service Account

Follow these steps to create a service account for the NetBrain IE system:

1. In the GCP Console, go to IAM & Admin - Service Accounts page, select PROJECT, and click CREATE SERVICE
ACCOUNT.

x Cloud Platform  &* NetBrain 8t Prol -

28 View products & services

FINNED

4l Hybrid Connectivity »

ita  Metwork services ¥
Wi VPCnetwork ¥
& compute Engine ’
)
8 Metwork Intelligence >

MORE PRODUCTS A

Marketplace
Billing

APls & Services ¥
Support »

¥
&=
I
w
B 1AME Admin |
=
]
)

Getting started

Compliance

security »
£ Anthos »
COMPUTE

NetBrain GCP Quick Setup Guide | 5



2. Add a new service account. Click DONE.

Google Cloud Platform 2« N

B Create service account

2
© sService account details
Service account name
| App_Netbrain_IE |

Display name for this senvice account

B Service account I *
| app-netbrainde-186  (@norse-fragment-296509.iam gsendceaccoun X (2 |

a L J

Senvice account description
-] | For Metbrain IE |

[Drescrite what this service account will do
]
S
» CREATE AMD CONTINUE
& Grant this service account access to project
@ (optional)
= . . )

© Grant users access to this service account (optional)

2
L

3. Go back to the service account page and click the service account created for the NetBrain IE system. On the

KEYS tab, click ADD KEY > Create new key.

= Google Cloud Platform 8¢ NetBrain GoogleCloud Host Pro1 w Q,  Search products and resources ~

e < App_Netbrain_IE

DETAILS PERMISSIONS KEYS METRICS LOGS

.
[

e Keys
2 A Service account keys could pose a security risk if i i you avoid iing service account keys and instead use the Workload |dentity Federation . You can leam more about the best way to authenticate servi
®
Add & new key pair or upload & public key certificate from an existing key pair.
a
Block service account key creation using organization policies.
o3 Learn more about setting organization policies for service accounts
o] ADDKEY ~
* Create new key Keycreationdate  Key expiration date
Upload existing key
-]
]
=
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4. Select JSON in the Key type field and click CREATE to create a service account key. The key file in JSON format
will be downloaded automatically. The file has the private key ID and value.
Create private key for "App_Netbrain_IE"

Downloads a file that contains the private key. Store the file securely because this key
can't be recovered if lost

Key type
@® JSON

QP2

CANCEL CREATE

5. Save this file in a folder you can remember. You will need this key to set up the GCP API Server later.
] o json - Notepad - o
File Edit Format View Help

"pr‘ivateikey; resu_maesma",

"private_key" ---BEGIN PRIVATE KEY----- \nMIIEvgIBADANBgkqhk iGIw@BAQEF AASCBKguggSkAgEAROIBAQDLATksDIIBrSZs\ M8/ AYVuGn+1v0QrOr4FVHxLjNgk1xdoogkIq9kTjt/ cvunMEhhoichZQrj ZUmMPL

nu4aBY31uDpptAm/ cOVmy2ZeKxkQYgula/quMsy txX01ZmmC ANHDT s FDKAZVit1IU\n6quRE8LTF rfbf2od6eBlesLLUL0Fp/ICMgTpTele JmnolTvc402ADuH I UnCBCeat ndJPgCy6/ 6D6UIFkSgeVIDF pUtyuc3he 7233 Duk 2XPCO7zmiqenI MI /1y6/ bHOLT
nXN7Up/MGAVVETxBMoZ3MQBLul ZXW7dSYVRH+P1X785P2Nuaz IEWBrAADF xVa

nIFrFMXB4Eo6vilkjxvoalaFxL1iSUaBbLAWLRyfpIdIHkoy4k IU7AeucPxyK /< JYI\nmUMmgAN+XwZGF8Qb592V/+tpqeVv1lUk9CEnVc 14bMRHg c+3ZQTOCRBgrE12T1Gqq \nkNjwAMYs SK6y gRCGNec 30dD5AZ91SHaMKF2AD7wrMel1R1EIKizeFG/ 1+RLVu/ /9d
nbpnBIsCIRUPk+vpxh3IYYxttU, P /CpF+MGUFPVgMLuQywoa7PHS1mddYMGrs

nA0ZP+IWocQUOTtvNI 1T1IN+1VQKEEQDTF AxzUMUrSONZPX1e46dPSnS 1NqUF2Uq +\nYs 2dwGH 5kd1gI SHGCKFRFuF KF ZEb2c geNSAmMA0Y JKFDEIvo90aKHXHTVVIS SISG\ n8k2 jnd2vin/ 23410 joXs /9Xe+ZtvAF cKMs9s /XGXEOTEKNCO7mmi84viouBdl 14X
nD43801y FPQKBEQC shjIMxIQFL sgvbUBNtnIYepdya+K72zk+UskeQKBgE7q

njBhULyejoTm/RFXs3tALqdBLSr1ng3Ub6 IxICnypfSCy85RKGKsAChBXNUDt 2N L \nid6 IcIKC jXkuBazvzVuCh7IQghwag/ 2zh58SCBVX04Xnq] EaDrdj7hQhng TXxk\nTpGe +H2eSZHrd0+ ZFIXNBOYVMHXBHSS L EARISEFpAOGBAIN3 7y FYeF JYS4tpmAvi
nKrsUSQUE2fteeDkYSZVbSdOSX] -END PRIVATE KEY----- \n",

"type": "

"114729283317209746985",

https://accounts.google. comfo/oauth2/auth”,

"https://oauth2.googleapis. com/token"

“auth_provider_x509_cert_url”: "https://nw.googleapis.com/oauth2/vl/certs”,

“client x589 cert_url": "https://wuw.googleapis.com/robot/vl/metadata/x509/ test1-264%48norse-Fragnent-296509. 1am. gserviceaccount . con”

"client_

Note: Copy all the private_key value inside the double quotation marks for Step 3 in section 1.3.3 Set Up API Server, shown as

below.

"private_key":
Lv

Flss
Iient_email

1.3.2. Assign IAM Permissions

There are different approaches to assign your IAM permissions to the service principal created before based on
various scenarios and needs. Recommended best practices are shown below,

Best Practices 1:
Scenario: Discover resources of all the Projects under the Organization.

Permissions assignment approach: Assign all the required permissions (or system roles) under the Organization.

Organization Roles Required:

NetBrain GCP Quick Setup Guide | 7



e Browser (ID: roles/browser)

e Compute Organization Security Policy User (ID: roles/compute.orgSecurityPolicyUser)
e Compute Viewer (ID: roles/compute.viewer)

e DNS Reader (ID: roles/dns.reader)

e Logs Viewer (ID: roles/logging.viewer)

e Monitoring Viewer (ID: roles/monitoring.viewer)

e Private Logs Viewer (ID: roles/logging.privateLogViewer)

e Service Usage Viewer (ID: roles/serviceusage.serviceUsageViewer)

Best Practices 2:
Scenario: Discover resources of some Projects under the Organization.

Permissions assignment approach: Assign the Organization required permission or system roles under
Organization level. And assign the Project required permission or system roles under Project level.

Organization Role Required:

e Browser (ID: roles/browser)

e Compute Organization Security Policy User (ID: roles/compute.orgSecurityPolicyUser)
e Logs Viewer (ID: roles/logging.viewer)

e Monitoring Viewer (ID: roles/monitoring.viewer)

e Private Logs Viewer (ID: roles/logging.privateLogViewer)

e Service Usage Viewer (ID: roles/serviceusage.serviceUsageViewer)

Projects Role Required:
e Compute Viewer (ID: roles/compute.viewer)
e DNS Reader (ID: roles/dns.reader)

The principal of these best practices is to ensure the resources discovered by NetBrain should be assigned with
IAM permission in the organization-scope or project-scope properly.

Required build-in Role for Org:
e Browser (ID: roles/browser)
e Compute Organization Security Policy User (ID: roles/compute.orgSecurityPolicyUser)
e Logs Viewer (ID: roles/logging.viewer)
e Monitoring Viewer (ID: roles/monitoring.viewer)
e Private Logs Viewer (ID: roles/logging.privateLogViewer)
e Service Usage Viewer (ID: roles/serviceusage.serviceUsageViewer)

Required built-in roles for Projects:
e Compute Viewer (ID: roles/compute.viewer)
e DNS Reader (ID: roles/dns.reader)
e Logs Viewer (ID: roles/logging.viewer)
e Monitoring Viewer (ID: roles/monitoring.viewer)
e Private Logs Viewer (ID: roles/logging.privateLogViewer)
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e Service Usage Viewer (ID: roles/serviceusage.serviceUsageViewer)

1. Go to IAM & Admin > IAM, select the GCP Organization or Project from the top drop-down menu and
click GRANT ACCESS.

Grant access to "netl " '

Grant principals access to this resource and add roles to specify what actions the
principals can take. Optionally, add conditions to grant access to principals only when a
specific criteria is met. Learn more about IAM conditions [

Resource

B netbraintech.com

Add principals

Principals are users, groups, domains, or service accounts. Learn more about principals
inlAM[2

New principals *

| ;s:iceaccountcom © o 4

Assign roles

Roles are composed of sets of permissions and determine what the principal can do

~with thistesource L eam more 2

1AM (optional) @ _ 5
Compute Viewer M ] + ADD IAM CONDITION .
Read-only access to get and list
information about all Compute Engine
resources, including instances, disks,
and firewalls. Allows getting and listing
information about disks, images, and
snapshots, but does not allow reading
the data stored on them.

SAVE CANCEL

[ Role *
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2. Paste the service account email under the New principals, select the system role required in the Role field,
and click SAVE.

cgle.com

Edit access to "ril S com'

2Y96509.1aM.gServiceaccount.com 3

Assign roles

Roles are p of sets of permi: 1s and ine what the principal can do
with this resource. Learn more (4

Role 1AM condition (optional) @
Browser M + ADD IAM CONDITION

Access to browse GCP
resources.

Role 1AM condition (optional) @
{ Compute Viewer - + ADD IAM CONDITION

Read-only access to get and list

information about all Compute Engine

resources, including instances, disks,

and firewalls. Allows getting and listing

information about disks, images, and

'snapshots, but does not allow reading

the data stored on them

Role IAM condition (optional)
{ DNS Reader h + ADD IAM CONDITION

Read-only access to DNS

resources.

Role IAM condition (optional) @
{ Logs Viewer - + ADD IAM CONDITION

Access to view logs, except for logs

with private contents

Role 1AM condition (optional) @
{ Monitoring Viewer M + ADD IAM CONDITION

Read-only access to get and list

1.3.3. Set Up API Server

Note: Before setting up your API server, read NetBrain Requirements for API Server Setu P first.

Follow these steps to set up a NetBrain GCP API Server:

1. Log in to your NetBrain IE system.

2. On the Domain Management page, select Operations = Discover Settings 2> API Server Manager, and click

+ Add API Server.

main Management Tenant:

Start P
Start Page Discover APl Server Manager ‘ cart Page

" Discover
Total ltems: All APl Source Tvoes v | | soorr ackup

© Network Setings B
AP| Source Type Server Name EndPaints Descripsion Username Fron: Server s

 DoNorSean ine Tune
Microsoft Azure crjilleo sus o Jlcs-0-74-4950.988e-d8cBc3921b4 FS1(192.168.28.
Microsoft Azure arjl 202 ce-cO6f-4824-82bd-31530428c1ab Fsi(192.16828, eork Definicion Topology Manager >
Cisco ACI 1o 42135 /192.168.48.135 QA Site Manager
Amazon AWS avilllo Account 747895045325 74045325 The Lab account that has configured tr... Schedule Task
Amazon AWS avillls Account 070113567925 ojiEs67925 Benchmark Tools >
Amazon AWS A 721655 Advanced Tools >
Amazon AWS cufillert DireciConnect {1589 AWS Account hosting Direcs Connect Domain Sertings N
Amazon AWS cofillert Clientpc A sq257447

Share Policy

Amazon AWS cofillert TGW_us-easc2 14002535 Hosting acceunt of Transic Gateway 1@ ...
Amazon AWS cofillert Clientvpc_B 2Jb<73057 Domain Health Report
Amazon AWS Coffillert TGW_uswest-2 3760514 Host Transic Gateway which connects cl.. T
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3. Set up the GCP API Server via Service Account.

Add External APl Server

N
A

* Server Name: | App_Netbrain_IE

Description: |For NetBrain |E APl Access

* APl Source Type: | Google Cloud W
* Access Method: | Service Account W
* Endpoint{QAuth Client/Service | Input Oduth Client (D/Service Account Ema
Account):

* Organization ID: | Input Google Cloud Orgonization D

* Private Key: | Input Google Cloud Private Key Content

* Front Server/Front Server Group: | select v

Managed Devices: 0

Test Cancel OK

Add External API Server configuration using the following information.

v' Server Name: a unique name.
v' Description: an optional field to describe this server.
v" APl Source Type: select Google Cloud.

v Access Method: select Service Account.

v' Endpoint: service account in email format just created. See step 2 of section 1.3.1 Create Service
Account.

v'Organization ID: your actual GCP Organization ID.

v Private Key: key value. See step 5 of section 1.3.1 Create Service Account. You can copy it from the
downloaded JSON file.

v Front Server: select one front server which can access GCP.

Note: If you have any issues while setting up an APl server, contact NetBrain Support.
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1.4. Set Up OAuth 2.0 Client

Google APIs use OAuth 2.0 protocol for authentication and authorization. To allow a client application such as the

NetBrain IE system, you need to set up the OAuth consent screen and then create an OAuth 2.0 client. NetBrain
system will request an access token from the Google Authorization Server, extract the token from the response,

and send the token back with the Google API.

Your App j Google Servers

Request token ———

% > User login & consent

User

. - ---- Authorization - - - -~ -4
code —
Exchange code <
for token
e - - - - Token response - - - - - 4

| Use token to call
Google API

1.4.1. Set Up OAuth Consent Screen

To set up OAuth Consent Screen for each project, refer to the GCP official guide:

https://support.google.com/cloud/answer/103116157hl=en#.
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https://confluence.netbraintech.com/confluence/display/SDNA/3.9.1.1+Method+1%3A+OAuth+2.0+Client
https://tools.ietf.org/html/rfc6749
https://support.google.com/cloud/answer/10311615?hl=en

= Google Cloud Platform & Project Test1 «

API OAuth consent screen

-
< Choose how you want to configure and register your app, including your
target users. You can only associate one app with your project.

or User Type

@ Internal @
4
Only available to users within your organization. You will not need to
submit your app for verification. Learn more about user type
—
T O External @

Available to any test user with a Google Account. Your app will start in
testing mode and will only be available to users you add to the list of test
users. Once your app is ready to push to production, you may need to
verify your app. Learn more about user type

Let us know what you think about our OAuth experience

Note: For security purposes, using the Internal User Type is highly recommended.

1.4.2. Create OAuth Client & Credential

Follow these steps to create an OAuth Client and credential:

1. In the GCP Console, go to APIs & Services > Credentials page, click CREATE CREDENTIALS, and select OAuth

client ID.

= Google Cloud Platform e NetBrain GoogleCloud Host Pro1 v
API Credentials W DELETE

APl key

-
“ Create credentials fo ac  |dentifies your project using a simple APl key to check quota and access
b OAuth client ID
API Keys Requests user consent so your app can access the user's data

O~ .

O Name Service account
Enables server-to-server, app-level authentication using robot accounts
¥ O A apikey: e d
O A erowser Help me choose

Asks a few questions to help you decide which type of credential to use

o

0Auth 2.0 Client IDs
O Name
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2. Select Web application in the Application type field.

NetBrain GoogleCloud Host

API & Create OAuth client ID

-

K A client 1D is used to identify a single app to Google's OAuth servers. If your app runs on
multiple platforms, each will need its own client ID. See Setting up OAuth 2.0 for more

pins

e information. Learn more about OAuth client types.

O~ [Application type * J

Web application

Android
Chrome app
= i0s

TVs and Limited Input devices
Desktop app

Universal Windows Platform (UWP)

3. Set the name and add http://localhost/oauth2callback as Authorized redirect URLs. Click CREATE.

= Google Cloud Platform & NetBrain GoogleCloud Host Prol v

APT & Create OAuth client ID

-
> A client 1D is used to identify a single app to Google's OAuth servers. If your app runs on

multiple platforms, each will need its own client ID. See Setting up OAuth 2 0 for more
e
w infermation. Learn more about OAuth client types.
o Application type *

[ Web application - ]
B

Name *

[ Web client name ]
_ The name of your GAuth 2.0 client. This name is enly used to identify the client in the
o console and will not be shown to end users.

The domains of the URIs you add below will be automatically added to
your 0Auth consent screen as authorized domains.

Authorized JavaScript origins @

For use with requests from a browser

+ ADD URI

Authorized redirect URIs @

For use with requests from a web server

URIs *

[ http:/flocalhost/oauth2callback

=+ ADD URI

CREATE CANCEL
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http://localhost/oauth2callback

4. Click DOWNLOAD JSON to download the OAuth credential JSON file locally. The client ID and secret are saved

in this file, and you need this information while setting up the API server in the NetBrain IE system.

OAuth client created

The client ID and secret can always be accessed from Credentials in APIs &
Services

QAuth access is restricted to the test users listed on your OAuth
consent screen

- Your Client ID

|59t loc D ]

Your Client Secret \
| GO auv ] |

¥ DOWNLOAD JSON

0K

1.4.3. Obtain Refresh Token

Follow these steps to obtain a refresh token from GCP via a built-in GCP OAuth Client Tool:

1. Download the GCP OAuth Client Tool from the link; http://download.netbraintech.com/tools/GCP-

OAuthClientTool.zip. Unzip the file GCP-OAuthClientTool.zip to a folder.

2. Rename the OAuth credential JSON file as client_secret.json, downloaded in step 4 of section 1.5.2 Create

OAuth Client & Credential, and move it to the same folder with auth_setup.py in the GCP OAuth Client Tool folder.

-GoogleCloud » 02.Documents » Final Version » GCP OAuth Client Tool » GCP Oduth Client Tool

~

[0 Mame

A auth_setup.py

client_secret.json

readme.tct

[ . Y 8

3. Double-click the auto_setup.py file and run it automatically to install Python library files.

NetBrain GCP Quick Setup Guide | 15


http://download.netbraintech.com/tools/GCP-OAuthClientTool.zip
http://download.netbraintech.com/tools/GCP-OAuthClientTool.zip

Trying to install required module: flask

Defaulting to user installation because normal site-pa
in indexes: htt /pypi.tuna.tsinghua.edu.c
imple

not writeable
://pypi.doubanio.com/simple, http://mirrors.aliyun.com

/bafdcb6delee26f

kB 344 k

ython\python37

hon\python37\site-packages (from click>=7.1]
0c465b99def112b68adcad26441019

9ec41927401e4laecaBaf6d16e78b5Se612bcad d417f646a9610a876)

Collecting MarkupSaf
Downloadi 74e745edd76eef70bf

aliyun.com /51137805d1b8d97

whl (288

It takes several minutes to install the python library installation the first time. The website browser with URL

http://localhost:9000/ will pop up automatically after the installation.

4. Click Authorize API Access to obtain the refresh token.

2 C @ localhost9000

Start GCP API access authorization procedure for OAuth 2.0 Client. and then generate the API access refresh token. which will be
used for NetBrain API server setup. If the APT access authorization has been granted already, if requires to revoke the AP access by

Authorize APT Access
running Revoke API Access procedure and re-do Authorize APT Access.

Revoke APT Access Revoke the GCP access authorization granted before.

5. Enter the account login information or select the correct user account for APl access.

Choose an account

to continue to Google API test

Il Tong
I 2 2gmail.com

mail.com

® Use another account

Terms

o}
o

English (United States) = Help

The current user account used in this step should have been assigned with proper permissions. For permissions

required, please refer to 1.3.2 Assign IAM Permission.

6. Click Allow to authorize the APl access.

16 | NetBrain GCP Quick Setup Guide



G sign in with Google

Google API test wants to access
your Google Account

o tonytong@netbraintech.com

This will allow Google API test to:

®  See, edit, configure, and delete your Google @
Cloud data and see the email address for your
Google Account.

Make sure you trust Google APl test

You may be sharing sensitive info with this site or app. You
can always see or remove access in your Google Account

Learn how Google helps you share data safely

See Google API test’s Privacy Policy and Terms of Service.

Cancel Allow

English (United States) - Help Privacy Terms

Finally, the refresh token will show up on the website browser. Also, a JSON file named credential.json will be
created automatically in the same folder as client_screte.json in the GCP OAuth Client Tool folder.

GoogleCloud » 02.Documents » Final Version » GCP QAuth Client Tool » GCP OAuth Client Tool

-

0 Name

# auth_setup.py

client_secret.json
credential json
readme,tx

7. Store the file in a local folder. Use the client ID, client secret, and refresh token value to set up the GCP API

Server later.

4 credential json E3 ‘H

Note: If you have issues obtaining the refresh token, contact NetBrain Support.

If you want to remove the existing credential access or obtain a refresh token again, follow these steps:

1) Click Manage credential access to remove the credential access.
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€« > C @ localhost:3000

. Go directly to the anthorization flow. If there are stored credentials, vou still might not be prompted to reauthorize
Authorize Credential .
the application.

Manage credential access Manage third-party apps with account access. After removing credential access, you can fetch refresh token gain.

2) Select the 3"-party apps that need to remove access and click REMOVE ACCESS.

< Apps with access to your account

Third-party apps with account access

You gave these sites and apps access to some of your Goagle Account data, including info that
may be sensitive. Remove access for those you no longer trust or use. Learn about the risks

o Has access to Geogle Cloud Platform

Has access to: ® Goegle Cloud Platform

See, figure, and delete your Google Cloud data

and email addres:

your Google
Access given on: 1 hour ago

See something suspicious? Report this app

3) Click OK to confirm.

Remove access?

Google API test will no longer have access to
your Google Account. You'll need to grant
access if you want to use this app or service
again.

Cancel OK

1.4.4. Set Up API Server

Note: Before setting up your API server, read NetBrain Requirements for API Server Setu P first.

Follow these steps to set up a NetBrain GCP API Server via OAuth Client:

1. Log in to your NetBrain IE system, select Operations - Discover Settings = API Server Manager in the

Domain Management page, and click the + Add API Server.
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Domain Management

APl Server Manager

Encfoinss Usermame
o5 0e74 495 5850 BcBec3321 b4 FS10192.168.28
e €067 4924 82bd 315304a8eTab F51(192.168.28 >
hi /192.168.48.135 QA Sire Manager
Amazon AWS 045325 The Lab accaunt that has configured tr. Schedule Task
Amazon AWS. 0] 567925 Benchmark Toals >
2. Set up the GCP API Server via OAuth Client.
Add External APl Server X
* Server Name: | App_NetBrain_|E
Description: For NetBrain |E APl Access
* APl Source Type: | Google Cloud W
* Access Method: | QAuth 2.0 Client w
* Endpoint{QAuth Client/Service | Input OAuth Client ID/Service Account Ema
Account):
* Client Secret: | Input OAuth 2.0 Client Secret
* Organization ID: | Input Google Cloud Organization ID
* Refresh Token: | Input OAuth 2.0 Refresh Token
* Front Server/Front Server Group: | select N4
Managed Devices: 0
Test Cancel OK

Add External API Server configuration using the following information.

v

v

v

4

Server Name: a unique name.

Description: an optional field to describe this server.
API Source Type: Select Google Cloud.

Access Method: Select OAuth 2.0 Client.

Endpoint: OAuth 2.0 Client ID. Refer to step 7 of section 1.4.3 Obtain Refresh Token. You can copy it from
the downloaded JSON file.

Client Secret: refer to step 7 of section 1.4.3 Obtain Refresh Token. You can copy it from the downloaded
JSON file.

Organization ID: your actual GCP Organization ID.
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v" Refresh Token: refer to step 7 of section 1.4.3 Obtain Refresh Token. You can copy it from the
downloaded JSON file.

v" Front Server/Front Server Group: select the front server/front server group that can access GCP.

Note: If you have any issues with the setup of an APl server, contact NetBrain Support.
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2. Start GCP Discovery

2.1. Discover Cloud Resources via APIs

Follow these steps to discover GCP networking resources via APIs:
1. Log in to your NetBrain |E system.

2. Click Discover on the Domain Management page.

Domain Management Tenant: Initial Tenant ~ Domain:
Start Page

Domain: Cloud-Test Description: (/] 2 Refrest
© Discover © Fine Tune O site © Schedule Task
.
80 &10 L0 u7
Last Discovered Devices Al Discovered Devices Sites Tasks
Resuk Succeeded 6100%) o 1
Duration 2mins 11 secs o o 3
BectionTime  11/25/2021 035810 PM o o 1
NMPSysODjectiD O 319
5
4 CurrentUsers  SessionCount2  ClientTyper | IE SmarcCll, Embe.. v Search. Q
Username ~ ClencType Machine Name 1P Address Browser LoginTime = End Session
4 B tonytong (NetBrain)
Session2 E I Chrome 11/26/2021, 31039 AM
4 B skanel (NetBrain)
Session E [ | Chrome 1126/2021, 85440 AM  End Session

3. Click + Select API Servers. Select the GCP API Server that you created. Click Start Discovery to start the GCP
discovery.

Domain Management

Start Page Discover
Discover View Historical Result Select
Discover Devices via SNMP/CLI  Network Settings

Metnod: @ Discover via Seed Routers (O Scan IP Range AccessMode:| SNMPand S5H/Telnet v | @  Discovery Depth:| 0

IP/Hostmame: | e.g: 10.10.10.1; NY_R1 Import IP List ~
Discover Devices via APl I+ Select AP| Servers | Unselect All

APIServers:  App NetBrain_IE :
fdvanzed Dpu-cns v

After the discovery finishes, the number of discovered objects will be displayed.
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Domain Management

Start Page Discover Schedule Task

Discover View Historical Result: 10/30/2021, 4:31:30 PM

Discover Devices via SNMP/CLI  Network Settings

Method: @ Discaver via Seed Routers () S¢an IP Range Access Mode: | SNMPand5SH/Telnet v @ Discovery Depth:| 30
IP/Hostname: | e.g 10.10.10.1; NY R1 Impart P List
Discover Devices via APl + Select AP| Servers  Unselect Al

APl Servers: | Original_QAuth  Temp_New_Second

Ak ¥l e Discovery

Discovery task is completed! but there are some Issues need to be resolved in Fine Tune. For troubleshooting, please Contact NetBrain.
For foundation license, 165 nodes discovered, 165 added to domain,
Discovered 2 P addresses, found 165 devices within 00:08:29. Duration spent in performing additional operations: 00:01:11.

@ DeviceLlog  [EExecutionlog [ Pluginlog  [E) Report

Discovery Summary  License Details

O &@¢ 6 606 6 6 O© o

Google VPC Rou... Google VPN Gat... Google Cloud R Google Cloud N... Google Firewll Google Load Ba... Google Partner . Google Private .
36 17 27 9 36 37 2 1

4. Click the Scheduled Task tab and run the Basic System Benchmark.

Domain Management i st & skanal

ne Tune Discover Schedule Task

Schedule Discovery/Benchmark  Schedle Data View Template/Parser  Schedule Qapp  Schedule Plugin  Schedule Platform Validation

+ Add Benchmark Task + Add Discovery Task Refresh
Ensbl.. TaskName Tipe Lzt Run Time Durstion Noxt Run Time Fro suthor
Sasic System Benchmark Benchmark Task 31302022, 1:03:24 M e Al DevicesNB_App_acc  Once NecBrain v
m) Scheduled System Discovery Discovery Task AllLive Network. Once NetBi Edic
Run Now
View Resutt
Delece

5. Open the network tree and select Google Cloud in the Category field to view the GCP resource. Select
Network View in the View field.

o
nNeSmaini
Network 508 X
+ Category
Azure v \4 =
— Built-in -
Fies AWS -
Azure
& Bigswitch
Sie Cisco ACI
ESXi
% I Google Cloud I
MERAK]
Network
MSXV

E Physical Network

Note: The Network View is only visible after the successful execution of the Basic System Benchmark.

All GCP resources discovered are displayed on the network tree. In addition, you can click a resource to open its
context map.
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NeSraini

etwork B ¥ X
+ Category View
Google Cloud % Network View 2% =
Fles b
* 4 Qriginal_OAuth{1)
Site 4 Qrganization: netbraintech.com(10)

i

Project HQ-1(3)
Project My First Project(3)
Project: My Project 65221(3)

¢
e

o fe

Project NetBrain GoogelCloud Ser Pro 5{6)

«* VPC Network: default{60905701 255449691 74){31)

4 2~ VPC Metwork: europe-central-hub-vpc(7442057383647796191)(8)
&1 VPC Router: europe-central-hub-vpc-router(744205738364779.
= Firewall: europe-central-hub-vpc-firews I(74420573836477961

4 5 Subnet europe-central-subnetieurope-central2){49935 778448

% VM: europecentralhub-vpc-snet1-vm1(36461306184654228...

' Subnet europe-north-subnetfeurope-north 1)(9840686352453...
' Subnet inte-https-load-balancer-subnetjeurope-west1}38664..
2 Subnet: private-service-connect-subnet{europe-north1){22937..
#i* Cloud Rourer: service-proS-to-ser-prod-cloudrouter(14549411...
+] Cloud VPN: service-pro5-to-ser-prod-vpn(49444170693231073...

o~ VPC Network: europewest-vpc{3200148140080597386)(8)
Load Balancers
Partner Interconnect

Dedicated Interconnect

e

Project: NetBrain GoogelCloud 5ta Pro(5)

e

Project NetBrain GoogleCloud Host Pra1(14)

i

Project: NetBrain GoogleCloud Host Pro2(6)

¢
e

Project: netbrain-eveng-lab(z)
Folder: Dep-A[2)
Folder: Dep-B{(2)

Temp_New_Second(1)

2.2. Discover Network Virtual Appliance

Network Virtual Appliance (NVA) can be loaded with any vendor's virtual machine (VM) images to support networking,
security, and other functions. NetBrain supports visualizing the topology and path of GCP NVA after discovery and

multi-source data merging.
To discover the Network Virtual Appliance (NVA), you need to:

v" Discover the Virtual Machine with Cloud API

v Discover Legacy Device with CLI

To perform the multi-source data merging properly via CLI discovery, go to the NetBrain |IE Discover page, click

the Advanced Options, and check Retrieve device/module/interface information.
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After the NVA multi-source data merging is finished, the GCP NVA device topology sample is shown below.

Net3maini

Run additional operations after discovery @

SNMP/CLI Discovery Options

I Retrieve device/module/interface information I

CLI forced timeout | 600 seconds

Discovery Methods via Seed Routers

Use NDP to discover neighbor devices
Find routing protocol neighbor vis SNMP

Use CLI routing table to discover next-hops

After Discovery via Seed Routers

[0 scan destination subnets
[0 scan all connected subnets

Minimum mask bits:

p— .
compoy vew
[Congeciont ] [Newerkview <
[ al

41 01.GCP Lab(1)
4 © Organization: nesbraintecn.cam(13)

1 & Project HQA(3)

b & Project: My Fist Project(3)

b & Project My Project 65221(3)

I & Froject Metrain GoogelCloud Ser Pro 5(6)

b & Project: NetBrain GoogelCloud Stz Prof5)

4 & Project: NetSrain GeogieCloud Host Pra(13)
) < VPC Nemwork 252.pC-5poked(5531699223624012510)12)
| < VPC Netwark cantral-vpe hus(E 165306842022363136)(24)
| < VPC Netwark csrl000v{264265525436175723))
b~ VPC Network: csr1000v-1(8257915747581355539)4)
b < VPC Network: default(763425967068754815)31)
| < VPC Netwark eastupcspoke (3528431364585511406)9)
) < VPC Nemwork europe/pespokes (6300201 11708338044)4)
) < VPC Netwark: westrpc.5poke (757826444601 2686400)7)
) < VPC Network: west2-

oke3(423514804030730547)(12)

CSR1000V: GCP-CSR10004(1}
I cs1000W(7944840858228023280)

T Looa Belancersizs)

) F Partner interconneati2)
1 Dedicated Interconnect
b & Project: NetBrain GaogleCloud Host Pro2(6)
I & Project Project Tesis)
I & Project Project Test 1(3)
b & Project SK3 projects)
I & Project: netbrain-eveng labis)
b ) Folder: DepAQ)
b ) Folder: Dep-B(2)
1 B 02.GCP - Second Org(1)

B O -  Stencis | OverallHealth Map Actions | I = —

&

Azure-CSR1000v

host-proji-csr1000v-vpes.

VBT

€sr1000v-1-router(8257915...
2sgie VEC Routar

7218208

. ~
host-proji-nav-fortigate:

Google Virtus! Macnine

S,
1721220188
1000y suBNe2(7959034415176279620)

MO owimisas
-4

€sr1000v-roliter(364265525...
Gasge vbC Rouer

esr1000v-firewal|(3642655...

Google Firawall

1721820028
1000 susnerl (31322131 45287338 551)

SLLVTELTL O

e

hos-pro-1-csr1000v-vpc-sn...
17218287
Google Vireus! Machine
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3. Set Up MPLS Cloud

Note: If you want to show the provider's MPLS network in the NetBrain IE system, you must set up the MPLS cloud by
following NetBrian's MPLS setup instructions. If not, skip this section.

NetBrain GCP support requires excluding all the Google Cloud Router devices connected with MPLS Cloud because
the Cloud Router in GCP is in the control plane and should not involve the data plane.

Follow these steps to exclude all the Google Cloud Router devices:
1. Log in to your NetBrain IE system.

2. Go to the Cloud Manager page from the Fine Tune tab of the Domain Management page. Add your new MPLS
or edit the existing one, and select Exclude Device.

Name:  ATT_NetBond

Cloud Type:

Dessrlgtion: | For AT NetBond MRLS Cloua

4 Static Interface 4 Dynamic Search Interface ~ I+Exdudg-| Search. QBB
!
. jce

1P GfPE Inte... PE Interface... VPN

3. Select the Google Cloud Router from the drop-down menu, and click the " icon to move all selected devices
from left to right. Click OK to finish.
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Select Devices by:

(Google Cloud Router
Google Cloud MAT

i guice
Google Cloud Router

Google Firewall

Google Load Balancer

Google Partner Interconnect

Google Private Service Connect Endpaint
Google VPC Router

Google VPN Gateway

@ east-router-1{3077338534562036868)
© east-router-2{1255432430008990873)
@ zecp-router-a(3364797130870022678)
© ecp-router-b{307091 732686562 1995)
@ netbrain-eveng-router(16313542605...
©second-org-cloud-router-1{70143824...
@ second-organization-us-central-vpe2-..

@ second-organization-us-east-cloudro...

Note: Failure to exclude all the Google Cloud Router devices connected to MPLS may cause the path calculation issue. If

() Device Group

O site

Vendor

Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...
Google Clo...

Google Clo...

Madel

Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router
Google Cloud Router

Google Cloud Router

27 Devices Selected

@ asia-vpcspoked{240067765155245. .
@ asia-vpc-spokeH493937754797832...
© asia-vpc-spoked-cloudrouten(2834...
©central-cloud-router-1(3385503352...
©central-cloud-router-2(4743863124...
@ central-vpc-hub-cloudrourer-1(807....
© cloudvpntunnel-router(903709844. ..
@-east-router-1(30773385345620363...
©east-router-2{12554324300059908...
©gecp-router-a(33647971308700226...
© gcp-router-b{30709173268656219...
@ netbrain-eveng-router{163135426...
@ second-org-cloud-router-1(701438...
@ second-organization-us-central-vp...
@ second-organization-us-east-cloud...

©serv-proj2-us-westd-cloudvpn{265...

B LI Ferpe p——

Cancel OK

you have any issue creating MPLS Cloud in the NetBrain IE system, contact NetBrain Support.
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4. Set Up Benchmark Task to Auto-Update GCP Data

The discovery process only retrieves the basic data of your GCP network and builds L3 topology. After the
discovery, you need to set up a NetBrain benchmark task to retrieve all data, including visual spaces and data

views.

To create a benchmark for GCP resources, complete the following steps.

1. On the Start Page, click Schedule Task.
2. On the Schedule Discovery/Benchmark tab, click Add Benchmark Task.
3. On the Frequency tab, define the task frequency.

4. On the Device Scope tab, check the Select external API servers to retrieve data check box and select the API
server for GCP.

Edit Benchmark Task X

Task Name: | Basic System Benchmark Description’ | Default system benchmark task
Frequency Retrieve Live Data CLI Commands Additional Operations after Benchmark Plugins Summary
Edselect Device I Select external API servers o retrieve data I
@ AllDevices (O Device Group () Site Total ltems: 7 All AP| Source Types v Search Q
(=] APl Source T Server Name EndPoints Description
§ Frewalls s Server e nkoin: szt
I Google Cloud App_NetBrain_|E 596315864195-hid7fehc... Discovery for GCP... I
Iy End Sy=emi239) 0 Amazon AWS 07-AWS Lab 041444721655
& Cloud(14) 0 Amazon AWS 05-AWS_Lab_Account 74 747895045325
[0 Amazon AWS 06-AWS_Lab_Account 07_. 070113567925
R (35)
@ Fowenas) O Microsoft Azure 03-Azure Tenant with Tw... f8b92556-1265-426e-be...
[0 Microsoft Azure 04-Azure Tenant for Cro...  chafdece-c96f-4924-82b..
[0 Google Cloud 02-GCP - Second Org 744042742179-di8563hg...

Note: It is highly recommended to re-use the “Basic System Benchmark” with a full benchmark task to ensure all GCP-
connected physical or virtual devices are selected within the device scope.

5. On the Retrieve Live Data tab, select the Google Cloud Basic Data check box, keep the default selected GCP
NCT tables as they are, and select BGP Advertised Route Table.
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Edit Benchmark Task

Task Name: | Basic System Benchmark Description: | Default systermn benchmark task
Frequency Device Scope CLI Commands Additional Operations after Benchmark Plugins Summary
[0 Stop retrieving after Hours | g Minutes
] WXLAN Address Table "

[ WXLAN Peer Table

[ wireless Endpoint Table
[ WLAN Summary Table

[ Zane Table

[0 Zoning Rule Priority Table

Zoning Rule Table
Google Cloud
Basic Data

4 ] Citrix ADM
() Basic Data
4[] WMware NSX-V
] Basic Data
4 [ Cisco ACI
] Basic Data
4 [ VMware vCenter
) Basic Data
4 [ Versa SD-WAN
"] Basic Data
4[] Amazon AWS T

Cancel Submit
6. On the Additional Operation After Benchmark tab, select all the checkboxes for:
= Update MPLS Cloud

» Update Public Cloud (Recalculate Google Cloud Virtual Route Table)

»= Update Build Topology
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Edit Benchmark Task x

Task Name: | Basic System Benchmark Description: | Default system benchmark task

Frequency Device Scope Retrieve Live Data CLI Commands Additional Operations after Benchmark Plugins Summary

W Update MPLS Cloud
Enable

w Update Public Cloud
Enable

Operation Name
Recalculate Cloud

Recalculate Cloud NCT

Operation Name
Recalculate AWS Virtual Route Table

Recalculate Azure Virtual Route Table

Recalculate Google Cloud Virtual Route Table I

w Build Topology

Enable

ieaoooan

Operation Name
IPv4 L3 Topology
IPv5 L3 Topology
L2 Topology

L3 VPN Tunnel

| ngiral Tanalnau

Cancel Submit

7. On the Plugins tab, add the GCP_VRT plugin following the steps below:

Scroll down to Execution Point: After rebuilding visual space and Click on Add Plugin
Navigate to Built-in Plugins > NB_System_Use

Select GCP_VRT and click “OK"
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8. Click Submit.

Task Name: | Basic System Benchmark Descriprion: | Default system benchmark task

Additional Operations after Benchmark m

Frequency Device Scope Retrieve Live Data CLI Commands Summary
4 Execution Point: After building L2 topology Execution order of this execution point Sequential v
+ Add Plugin
Enable  Location Input Description Device Group
Built-in Plugins/NB_System_Use/E_ N/A To establish the L2 topology for CheckPoint de..  N/A
Built-in Plugins/NB_System_Use/E.. N/A To establish the L2 topology for Transparentd... N/A
4 Execution Point: After completing full topology building Execution order of this execution point: Sequential Vv
+ Add Plugin
Enable  Location Input Description Device Group
Built-in Plugins/NB_System_Use/O0... None This plugin is no longer in use. N/A
a |Exzmnun Point: After rebuilding visual space Execution order of this execution point: Sequential v
+ Add PI; ;\n
Enable  Location Input Description Device Group
Built-in Plugins/NB_System_Use/l... [] This plugin is used to identify the management... N/A

Add Plugin

4 [ [ All Plugins

4 [ [ Built-in Plugins

I O E Multisource

4 @ F]NB_System_Use

b [0 E Extend_L2 Topalogy
b 1 1 Extend_L3_Topology

b [ & Open_Topology

MWS_PostRetrieve

0 [ AWS_VRT

O [ Azure VRT

[ El Debug_separated_0912
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5. Appendix

5.1. NetBrain Requirements for API Server Setup

*= The minimum resource unit for an API Server scope is a Project that includes all the resources under it.
Therefore, NetBrain does not recommend separating resources under one Project to a different API

Server.

= The API Server is associated with an Organization. Use IAM to control the project level of resources API

discovery. If you have multiple Organizations, set up at least one API Server for each Organization.
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